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1. Installation of the DEMO model and getting started 
 
This section aims at guiding the user with the installation of the all the system components 
(VEDA-FE, VEDA-BE, GAMS source code, templates, etc.) and getting started with the DEMO 
model. You can access the various components of the system and DEMO model from the 
download page of the KanORS website (see Figure 1): http://www.kanors.com/ETSAPdnld.asp. 
User name and password may be obtained from KanORS: amit@KanORS.com. 
 
Figure 1. Download page1 
File ��������� ��������

VEDA-FE-2.0.40 [Installation] 28 Jun 2005 7:41:20 AM 11.3 Mb 

VEDA-FE-2.0.46 [EXE Update] 16 Jul 2005 1:25:05 PM 2.4 Mb 

VEDA-BE-4.5.35 [Installation] 27 Jun 2005 2:57:22 AM 9.8 Mb 

None [EXE Update] Upload Pending  

MARKAL Source Code V5.4g 18 May 2005 6:23:36 PM 0.5 Mb 

TIMES Source Code V1.4.0 28 Jun 2005 12:02:57 AM 0.2 Mb 

GDX2VEDA 19 Oct 2004 4:47:39 AM 0.1 Mb 

DEMO Templates MARKAL 28 Jun 2005 1:03:15 AM 0.4 Mb 

DEMO Templates TIMES 28 Jun 2005 1:03:15 AM 0.4 Mb 

VEDA-BE Databases Upload Pending  

<3 Days 4-7 Days 8-14 Days >14 Days  
* “Upload Pending” means that the file does not exist or is not available. 

                                                 
1 The content of the download page may be different than presented here as newer versions of the system 
components are posted. 
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1.1. VEDA-FE and templates 
 
1.1.1. System folder 
 

- Download the installation file “VEDA-FE-1.X.XX [Installation]”, anywhere on your 
computer. Double-click the “VEDA_FE.msi” file; the installation form will open 
(Welcome to the VEDA_FE Setup Wizard).  

o If a previous version of VEDA-FE is already installed on your computer, you 
have to uninstall it by choosing the option “Remove VEDA_FE” and click the 
‘Finish’ button. Once VEDA-FE has been successfully removed, click the 
‘Close’ button to exit and go to the next step for installing the new version. If the 
previous version is older than 1.7.50, you should also uninstall it from the control 
panel, and delete the entire folder where it was installed. 

o If this is the first ever installation or if any old versions of VEDA-FE have been 
uninstalled, click the ‘Next’ button. By default, VEDA-FE is installed in 
C:\Program Files\VEDA_FE. Click the ‘Next’ button to install in this folder. 
Otherwise, use the ‘Browse…’ button to select any existing folder or type a new 
folder name (e.g. C:\VEDA_FE\). Click the ‘Next’ button to start the installation. 
Once VEDA-FE has been successfully installed, click the ‘Close’ button to exit. 

 
- The folder in which you installed VEDA-FE is called the system folder. It is important to 

keep the “VEDA_FE.msi” file where it was downloaded, or to move it in the system 
folder. For subsequent installations, always download this file at the same place.  

 
- Download and unzip the execution update file “VEDA-FE-1.X.XX [EXE Update]” in the 

system folder. Replace the old version with the new version. This is required only if the 
version number is higher than what you have installed. If there is no execution update file 
available (Upload Pending), it means that the installation file is complete and no 
additional updates are required. 

 
- In the system folder, create a sub-folder GAMS_SrcMARKAL, where you download and 

unzip the “MARKAL Source Code VX.X.X” file if you are using MARKAL models, 
or/and create a sub-folder GAMS_SrcTIMES, where you download and unzip the 
“TIMES Source Code VX.X.X” file if you are using TIMES models (or both). 

 
- In the system folder, create a sub-folder GAMS_WrkMARKAL or/and GAMS_WrkTIMES, 

where you download and unzip the “GDX2VEDA” file. 
 
1.1.2. Template folder 
 

- Create a new folder (using any name you want), anywhere on your computer. This is the 
template folder, where you download and unzip the “DEMO Templates MARKAL” file 
or the “DEMO Templates TIMES” file. If you use both types of models, create two 
different template folders. While unzipping, make sure that the "Use folder names" 
option is checked in WinZip. This is to assure that the following sub-folders are created 
automatically: Databases, SuppXLS and SubRES_Tmpl.  
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1.2. VEDA-BE 
 

- Download the installation file “VEDA-BE-4.X.XX”, anywhere on your computer. 
Double-click the “VEDA_BE.msi” file; the installation form will open (Welcome to the 
VEDA_BE Setup Wizard).  

o If a previous version of VEDA-BE is already installed on your computer, you 
have to uninstall it by choosing the option “Remove VEDA_BE” and click the 
‘Finish’ button. Once VEDA-FE has been successfully removed, click the 
‘Close’ button to exit and go to the next step for installing the new version. If the 
previous version is older than 4.5.15, you should uninstall it from the control 
panel. 

o If this is the first ever installation or if any old versions of VEDA-BE have been 
uninstalled, click the ‘Next’ button. By default, VEDA-BE is installed in 
C:\Program Files\VEDA_BE. Click the ‘Next’ button to install in this folder. 
Otherwise, use the ‘Browse…’ button to select any existing folder or type a new 
folder name (e.g. C:\VEDA_BE\). Click the ‘Next’ button to start the installation. 
Once VEDA-FE has been successfully installed, click the ‘Close’ button to exit. 

 
- It is important to keep the “VEDA_BE.msi” file where it was downloaded, or to move it 

in the system folder. For subsequent installations, always download this file at the same 
place. 

 
- Download and unzip the execution update file “VEDA-BE-4.5.XX. [EXE Update]”, in 

the system folder. This is required only if the version number is higher than what you 
have installed. If there is no execution update file available (Upload Pending), it means 
that the installation file is complete and no additional updates are required. 

 
- Download the “VEDA-BE Databases” file, which contains pre-defined sets and tables to 

look at results of MARKAL or TIMES models. Unzip the file in the system folder where 
you installed VEDA-BE (C:\Program Files\VEDA-BE), with the “use folder names” 
option checked in WinZip. This will unzip the files into two subfolders: 
\databases\MARKAL, and \databases\TIMES. Before importing the results, point to the 
appropriate folder via “open database” option in the File menu of VEDA-BE. 

 
1.3. Getting started with the DEMO model  
 
1.3.1. Before import 
 

- Before running VEDA-FE, make sure that the decimal symbol is set as dot “.” and not as 
comma “,” on your computer (from Windows Control Panel, Regional Settings, 
Numbers).  

 
- Open Excel, select the “Add-Ins…” option from the Tools menu ad click the ‘Browse…’ 

button. Locate the file “Veda_SaveCode.xls” in the system folder where you have 
installed VEDA-FE. Highlight the file, click ‘OK’ and close Excel. 
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- Launch VEDA-FE (double-click on the gray icon created on the desktop). 
 
- If you do not have the appropriate license, you can also follow these instructions to get a 

license code online: 
o Click the ‘Get Key Online (www.KanORS.com)’ button. 
o Enter your e-mail address, click the ‘Generate’ button and close VEDA-FE. 
o The license code for VEDA-FE will be mailed immediately from KanORS 

Consulting Inc as an attached file. 
o Save the license file in the VEDA-FE system folder. 
o Re-launch VEDA-FE. Your license code will appear automatically. Enter your e-

mail, name and organization and click the ‘Register Me Now’ button. 
o Once your license has been successfully updated, click ‘OK’.  
o If you have problem at this stage, contact KanORS directly: amit@KanORS.com. 

 
- Make sure that you are configured for the appropriate model, i.e. MARKAL or TIMES. 

The current active model type appears in the upper left corner of the VEDA-FE window 
(e.g. “VEDA Frond End-1.X.XX: TIMES model”). To select a different model you can 
use the commands “Switch to MARKAL” or “Switch to TIMES” from the File menu.  

 
- Create a new database (Menu: File, New Database) and give it a name. 
 
- Select the path of the template folder. To create a new path, click the ‘New’ button, 

locate the path and click ‘OK’. Highlight the new path and click ‘OK’. If the right path is 
already declared, highlight it and click ‘OK’. Note that you can check the ‘Full Import’ 
box if you want to re-import all the templates in the database; the import will start at step 
2 (red color level) for all sectors and regions (see Figure 5). Normally, since the 
templates have already been imported in a VEDA-FE database before their released on 
the website, the access databases (in the ‘Databases’ sub-folder of the template folder) 
already contain the template data, and the import process starts at step 6 (Update 
Database). Consequently, if you have not modified any templates, there is no need to 
check the ‘Full Import’ box. 

 
Two subsequent forms will open to declare the time slices and the time-periods. For time slices (see  
 
 
 

 

 

- Figure 2): you can click the ‘Apply’ button to use those declared by default: three 
seasonal slices (summer/winter/intermediate) and two daily slices (day/night). You can 
also define different time slices by typing the letter code in the ‘SEASON’ and 
‘DAYNIGHT’ columns. In this example, there are four seasonal slices 
(spRing/Summer/Fall/Winter) and three daily slices (Day/Night/Peak). 

 



 
 

 5 

 
 
 
 

 

 

Figure 2. Add time slices 

 
 
 

- For time-periods: 
For MARKAL models, you can provide the starting year, period length and number of periods in 
the three yellow cells (see  

o Figure 3). The time-periods will be defined automatically as soon as you leave the 
last yellow cell. 

o For TIMES models, you can enter the starting year in the first yellow cell (e.g. 
1998 or 2000) and the period lengths in the other yellow cells below. The first and 
last years of each period, as well as the milestone year, will be calculated 
automatically. If you use 2000 as the first year, use 1 as the first period length. 
You can choose your own period lengths for the subsequent periods (see Error! 
Reference source not found.). 

o To save the time-periods, click the “Remember” button and give a name to the 
period definition, click “OK” and “Apply”. A message will indicate that the 
changes are updated, click “OK”.  

o To use the same period definition the next time you create a new database, click 
the “Recall” button and choose the name of the appropriate period definition in 
the combo. Click “Back” and “Apply”. A message will indicate that the changes 
are updated, click “OK”. 
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Figure 3. Add time-periods (for MARKAL models) 

 
 
Figure 4. Add time-periods (for TIMES models) 

 
 
- In the template manager (see Figure 5), check the box to generate “Vintage Bounds” if 

needed. This is needed when the technology repository of a model has been created 
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following a certain naming convention, i.e. where the last 2 or 3 digits of the technology 
name refer to the vintage of the technology and where there are similar technologies with 
different vintages (and different costs and efficiencies). Consequently, investment bounds 
are automatically created for the older technology when a new one becomes available 
(e.g. if an electric car is available in 2015, the same electric car available in 2010 will 
automatically have an investment bound of 0 in 2015).      

 
- Verify if the appropriate transformation file is selected under the “TFM file” box. If not, 

or if you see question marks, double-click in the box and locate the appropriate 
transformation file, in the SuppXLS sub-folder of the template folder (e.g. 
DEMO_QDATA.xls).  

 
Figure 5. Template manager 

 
1.3.2. New technologies and other subRESs import 

 
- Import the new technologies into the database.  

o Select ‘SubRES’ and then ‘Import’ from the Advanced Functions menu.  
o Select the ‘SubRes_B-NewTechs.xls” file (in the SubRES_Tmpl sub-folder of the 

Template folder) and click ‘Open’. Note that this sub-folder contains also the 
transformation files that apply to new technologies (SubRes_B-
NewTechs_Trans); you do not have to select and import this file. 
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o Once the import is complete, the SubRES view opens. You see a region-
technology matrix, where you can choose technologies for each region. Note that 
the new technologies are classified by sector (new technologies for ELC appear 
first by default, see the second combo on the upper right corner of the window). 
Any selection modifications should be saved for each sector separately; click the 
‘Save’ button, than ‘Yes’, and ‘OK’. If you select another sector without saving, 
your modifications will be lost. 

o Currently, it is needed to un-select all new technologies for the global region 
(GLB) in all sectors. Since the new technology repository has already been 
created in VEDA-FE before the released of the model, the new technologies have 
already been un-selected for GLB in all sectors.  

o After saving your modifications or if you did not make any modifications, ‘Close’ 
the window. The browser will open with the new technologies imported. 

 
- Optional and currently non available: It is also possible to import additional sections of 

the reference energy system (subRESs), like hydrogen or sequestration technologies, into 
the database. 

 
o Select ‘SubRES’ and then ‘Import’ from the Advanced Functions menu.  
o Select the ‘SUBRES_Hydrogen.xls’ file (in the SubRES_Tmpl sub-folder of the 

Template folder) and click ‘Open’. Note that this sub-folder contains also the 
transformation files that apply to each SubRES (e.g. 
SUBRES_Hydrogen_Trans.xls); you do not have to select and import this file.) 

o Once the import is complete, the SubRES view opens. You see a region-
technology matrix, where you can choose technologies for each region. Note that 
the new technologies are classified by sector (new technologies for ELC appear 
first by default, see the second combo on the upper right corner of the window). 
Any selection modifications should be saved for each sector separately; click the 
‘Save’ button, than ‘Yes’, and ‘OK’. If you select another sector without saving, 
your modifications will be lost. 

o Currently, it is needed to un-select all new technologies for the global region 
(GLB) in all sectors. 

o After saving your modifications or if you did not make any modifications, ‘Close’ 
the window. The browser will open with the new technologies imported. 

o You can import another SubRES using the same instructions (e.g. 
SubRES_Sequestration.xls) or close the browser and go back to the template 
manager. 

 
- Click the ‘IMPORT DATA’ button to start the import process. This will bring all the 

cells (templates) to ‘blue’ from whichever state (color) they are in.  
 

- During the import process, note pad files may open, for example the list of commodities 
not declared in templates for some regions. You can ignore this list and close the file, 
because these commodities are not used in those particular regions. Moreover, it is 
possible to see a list of invalid PCG (Primary Commodity Group) declared in the 
templates (for TIMES models). These are temporary warnings and they will be corrected; 
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this file can also be ignored and closed. These note pad files do not stop the import 
process.  

 
- At the end of the import process (when all cells are blue) you can follow, in the lower left 

corner of the window, the conversion of the VEDA attributes (as declared in the 
templates) into MARKAL or TIMES attributes. When the conversion is finished the 
browser opens automatically. 

 
1.3.3. Scenario import 
 

- Import the scenarios into the database.  
o Select ‘Scenario Data’ and then ‘Import’ from the Advanced Functions menu.  
o Select any scenario file, ‘Sce_*.xls’ (currently, only one scenario is available: 

Scenario_InterpolationSettings.xls) in the SuppXLS sub-folder of the Template 
folder and click ‘Open’. Note that you can select more than one file at the same 
time, although it is recommended to select only few scenarios at the same time, 
since there is a limit on the amount of data you can import at the same time. If 
you exceed this amount, you will get an error message.  

o You can follow the scenario import process and then, the conversion of the 
VEDA attributes (as declared in the templates) into MARKAL or TIMES 
attributes, in the lower left corner of the window. 

 
- Once the import process is complete, the browser will open automatically. To view the 

browser at any other time, you can also select “Browse/Edit” from the Basic Functions 
menu or press F7 on your keyboard. Items may be selected and viewed as desired. 

 
1.3.4. Solve 
 

- To submit a job run, select “Solve” from the Basic Functions menu or press F9 on your 
keyboard. Select the scenarios (e.g. Base and EXTRAINFO), the ending year (e.g. 2100) 
and give a name to the run. Click the ‘Solve’ button. A command window will open 
displaying the progress of the matrix generation, solver and reporting of the MARKAL or 
TIMES model run.  

 
- Make sure that GAMS (General Algebraic Modeling System) is installed on your 

computer before solving a MARKAL or TIMES model. Download the file “GAMS 
Installation” using the “Need GAMS?” link for more information on how to install 
GAMS and get a license. 

 
1.3.5. Look at results 
 

- Launch VEDA-BE to import and look at results.  
o If you are using the flavor by default of VEDA-BE (with a single model), you can 

import results directly (Menu: Results, Import/Archive or F7). 
o If you are using multiple flavors of VEDA-BE (with multiple models), open the 

databases where you store the tables and sets for this flavor (e.g. C:\Program 
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Files\VEDA_BE\Databases\DEMO) and import the results (Menu: Results, 
Import/Archive or F7). 

 
- Normally, VEDA-BE locates the results folder of VEDA-FE automatically 

(GAMS_WrkMARKAL or GAMS_WrkTIMES). In case of problem, you can click the 
"Manage Input Files Locations" button and then the “Add Path” button, locate the 
GAMS_WrkMARKAL or GAMS_WrkTIMES sub-folder (e.g. C:\Program 
Files\VEDA_FE\GAMS_WrkTIMES). Click “Close” and then “OK” to import the 
results. 

 
- Select a table from interest from the “Table Definition” pull-down list, or build your own 

new table. Then click the “View Table(s)” button to see the resulting data cube. Use 
drag-and-drop and the right mouse to rearrange the results table as desired. See the 
VEDA-BE Users’ Guide for more information on this software at 
http://www.kanors.com/userguidebe.htm. 


